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Preface 

 
The document herein was produced by the International Medical Device Regulators Forum 

(IMDRF), a voluntary group of medical device regulators from around the world.   
 
There are no restrictions on the reproduction, distribution or use of this document; 

however, incorporation of this document, in part or in whole, into any other document, or its 
translation into languages other than English, does not convey or represent an endorsement of 
any kind by the International Medical Device Regulators Forum.
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1.0 Introduction 

 
The purpose of this document is to act as guidance to all those involved in developing 

and issuing International Medical Device Regulators Forum (IMDRF) documents and it is 
designed to be used with the accompanying Microsoft Word IMDRF Document Template.  By 
using the IMDRF Document Template, members involved in developing new documents will be 
using a prescribed format, resulting in each new IMDRF document having a common and 
consistent appearance.  This in turn, will contribute to their important use in achieving 
harmonized regulatory practices for medical devices around the world.  
 

Comments or questions about the use of the Document Template or this guidance 
document should be directed to the IMDRF Secretariat. 

2.0 Scope 

All persons involved in or responsible for the creation or issuance of IMDRF documents 
are encouraged to read this document and to use the accompanying IMDRF Document Template. 

 
The IMDRF document template was created, and should be used, in the application 

Microsoft Word. 

3.0 References 

Throughout this document, references are made to the IMDRF document entitled “Operating 
Procedures”. 

4.0 Definitions 

Template: the file ‘IMDRF document template.dot’ 
 
Field:  a pre-formatted area of the template where specific text can be entered. 
 
Click:  one mouse click, using the primary button on the mouse 
 
Right-click: one mouse click, using the secondary button on the mouse 
 
Double-click: two mouse clicks, using the primary button on the mouse 

5.0 Document Format 

The following document format requirements have been incorporated into the IMDRF 
Document Template.   
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5.1 Word Processing Software 

Microsoft Word was chosen as the word-processing software for the IMDRF Document 
Template since it is the most commonly used software amongst IMDRF members.  Documents 
not created using the template will be converted by the IMDRF Secretariat prior to posting. 

5.2 Paper Size 

While it is preferable that a common paper size be used when creating IMDRF 
documents, it is recognized that different standard paper sizes are used around the world, i.e., A4 
Letter size in Europe and Letter size (81/2" x 11") in North America.  Document authors should 
therefore be advised that the arrangement of text from page to page in a document may be altered 
by the IMDRF Secretariat in preparation for posting on the IMDRF website. 

5.3 Margins 

All margins of IMDRF documents except the top margin, i.e., bottom, right and left, 
should be 2.54 centimeters (cm) unless a smaller margin is warranted, i.e., a page containing a 
schematic or flow chart that will not fit without the use of smaller margins.  The top margin for 
all IMDRF documents will be 2.0 cm.  

5.4 Font 

All IMDRF documents will be generated in Times New Roman font, pitch 12.  Document 
headings and subheadings will be numbered, i.e., 1.0, 1.1, 1.2, 2.0, etc. and headings will appear 
in bold text, pitch 14.  Sub-headings will appear in bold text, pitch 12.  Each word of a heading 
or sub-heading should be capitalized. 
 
Examples: 2.0 Requirements 
 

2.1 Role of the Auditor 
 
 
 
 

5.5 Line Spacing 

IMDRF documents will be single-spaced with a double space appearing between text and  
each heading or sub-heading and a double space appearing between each separate section and 
sub-section.  Paragraphs will be separated by a double space. 
 
Example:  2.0 Method of Estimating Audit Duration 
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This document provides guidelines for auditing organizations responsible 
for planning, carrying out and documenting quality system audits.... 

 
2.1 Factors Which May Increase the Initial Audit Duration 

5.6 Page Numbering 

All pages of a IMDRF document, with the exception of the cover page, will be numbered 
in the bottom right hand corner of each page, using the format “Page 1 of X”, with the page 
number appearing within the footer on each page (see section 8.4). 

6.0 Document Elements 

 IMDRF members involved in IMDRF document development should consider the 
inclusion of each of the following sections.  It is to be noted however, that in some cases, 
depending on intent or scope, a IMDRF document may not include a particular section because it 
does not apply.   

For convenience, each of these sections with the exception of Section 6.1 Table of 
Comments has been included in the IMDRF Document Template. 

6.1 Table of Contents 

All IMDRF documents over four (4) pages in length will have a Table of Contents 
specific to heading and sub-heading level. 
 
Example:  1.0 Introduction.....................................2 
 

2.0 Types of Audits...............................2 
 

2.1 Initial Audit.........................3 
2.2 Surveillance Audit...............3 
2.3 Special Audit.......................4 

6.2 Preface 

 All IMDRF documents, regardless of their authoring group or intent, will bear a preface 
designed to summarize the composition of the IMDRF and its goals as an organization.  The 
preface of any given document should not bear any document-specific information as this may 
be found in the Introduction section (see Section 6.4).   
 
 For convenience, the IMDRF Document Template has been formatted to include the  
“generic” preface statement shown in Appendix A. 
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6.3 Cover Page 

Documents at either the Working Draft or Proposed Document stage will bear a cover 
page containing the following information: 
 

(A) the title of the document; 
(B) the authoring group, e.g., Study Group 1; 
(C) the date of issue, i.e., the date that the document was created on or was last 

worked on 
                        Note that the acceptable date format is Day Month Year, e.g., 25 June 2000  

(D) the words “Global Harmonization Task Force”, and 
(E) the document identification code, as described in Section 3.0 of the Operating 

Procedures document. 
 

For convenience, each of the pieces of information listed above has been included as 
fields in the cover page of the IMDRF Document Template. 

 
Final Documents endorsed by the Steering Committee will use the formal cover page 

attached as Appendix B to the Operating Procedures document, with the cover sheet being 
signed by the Chair of the organization at the time of endorsement. 

6.4 Introduction 

 This section of the document should lay out the background leading to the document’s 
development and should include identification of the authors or authoring group involved in its 
creation, the document’s current stage of development, a brief summary of the process used to 
obtain comment on the document throughout its development (if applicable), a description of the 
document’s intended audience and a statement of the document’s purpose. 
 
 The introduction may also include reference to a contact person, to whom comments or 
questions about the document should be directed. 
 

6.5 Scope 

The scope of a IMDRF document should outline its applicability to a particular aspect or 
aspects of medical device regulation and/or the usefulness of the document to different sectors of 
industry or government. 
 

The scope of the document should also clearly state any exclusions that may apply. 
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6.6 References 

This section should list any references that may have used in developing the document and/or 
any international standards that are referred to in the document, i.e., ISO 9001:1992.   
  

If no references were used, enter “Not Applicable” in the template. 

6.7 Definitions 

This section should contain a lexicon of all terms found within the document for which 
there may be different interpretations, the purpose being to provide the interpretation used by the 
document creators and therefore to facilitate implementation or use of the document by 
eliminating any uncertainties about the meaning of a certain term or requirement.   
 

Each term in the lexicon should appear in bold text followed by a colon and the definition 
in an indented paragraph.  See Section 4.0 for examples. 
 

Enter ‘Not Applicable’ in the template, if appropriate. 

6.8 Document Body 

Since each IMDRF document will differ in subject matter, it is expected that the body of 
each document will differ in the sections that it contains also.   For example, a document on 
auditing of quality systems may include sections on the audit team, types of audits and the audit 
process while another document on essential principles of device design may include sections on 
chemical properties and reduction of microbial contamination.  

 
 The organization of the text body of each document is therefore at the discretion of each 
authoring group, provided it is broken into logical and numbered sections.  For convenience, the 
header and text for the first document section have been created as fields in the IMDRF 
Document Template.  Additional sections should then be added as required. 
 
 The numbering of headings and sub-headings is controlled using Styles, which can be 
accessed from the pull-down menu on the control bar.  Using the styles included in the template 
ensures that the table of contents can be generated correctly. 
 
 The default style setting is “Normal” and this style should be used for all text in a 
IMDRF document, with the exception of headings and sub-headings, etc.    
 
 Style “1.0 Heading 1” should be used for the titles of major sections within a document 
because it will automatically apply top-level numbering, i.e. 1.0, 2.0 …, to the text.   There is no 
limit to the number of sections you can create in a document. 
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 Style “1.1 Heading 2” should be used for sub-headings within major sections of your 
document because it will automatically apply second-level numbering, i.e. 1.1, 1.2 …, to the text.  
   

Style “1.1.1 Heading 3” should be used for sub-sub-headings if required because it will 
automatically apply third-level numbering, i.e. 1.1.1, 1.1.2 …, to the text. 

6.9 Examples 

The use of examples is encouraged as a way of promoting understanding of the document 
text.  Examples should be preceded by the word “Example:” followed by the actual example in 
an indented paragraph (see the examples in this document). 

6.10 Appendices 

All diagrams, forms or flow charts, etc., not included in the body of the document should 
be included as appendices at the end of the document.    

 
The IMDRF Document Template has been formatted to include a blank page with the 

word “Appendices” on it and this should be used to separate the body of the document and its 
appendices.   
  
 The template also comes formatted with one appendix (labeled Appendix A) and a field 
in which the title of the first appendix can be entered.  If necessary, additional appendices should 
be added, following the same format.  Alternatively, if there are no appendices, these sections of 
the document template can be deleted. 

7.0 Installing the IMDRF Document Template 

Before installing the document template, ensure that you close any Microsoft Word 
windows that are currently open on your computer.    

 
The IMDRF document template is a Microsoft Word file, called “IMDRF document 

template.dot”.  This file can be found on the IMDRF web site (www.IMDRF.org) on the General 
Information page under the “IMDRF Documents” heading. 
 

This file should be saved to your computer, using the instructions on the web site.  It 
should then be copied to the “Templates” folder in your Microsoft Word or Microsoft Office 
folder.  If you are not sure where this is, contact your technical support provider.  A typical 
location would be C: \ Program Files \ Microsoft Office \ Templates. 
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8.0 Using the IMDRF Document Template 

8.1 Opening the Document Template 

The following instructions will allow you to open the template and start to create a new 
document: 
 

(A) Start Microsoft Word;   
(B) Select “New” from the “File” menu; 
(C) In the ‘New’ window that appears, select “General”; 
(D) Double-click on the icon marked “IMDRF Document Template.dot” (if the icon is 

not there, go back and make sure that you followed the installation instructions in 
Section 7.0), and 

(E) A new, untitled Word document, with the template fields in place, will appear. 
 

At this point, it is recommended that the new document be saved with an appropriate 
name.  Completed work should also be saved regularly to avoid loss in case of system failure. 

8.2 Filling in the Template 

The template comes with a number of pre-defined fields allowing pertinent information 
to be entered in the correct place.  These fields are identified by square brackets enclosing 
instructions about what information should be included.   
 
Example: [Click here to enter document title].  
 

Clicking on the field will highlight it,. 
 

Example: [Click here to enter document title].  
 

When the field is highlighted, text can be typed into it.  Note that the appropriate 
formatting for that section of the document will be automatically applied. 

8.3 Using the Template Header 

 The IMDRF Document Template has been formatted to include a document header which  
appears on every page except the cover page.  The header provides the following information: 
 

(A) the document title and document identification code; 
(B) the authoring group, and 
(C) the document status, i.e., Final Document, Proposed Document, Draft#4, etc. 

 
  To edit the document header, follow these instructions:   
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(A) Go to any page other than the cover page, and 
(B) Select “Header and Footer” from the View menu to display the header/footer 

control bar:  

 
and the header region in a hatched box at the top of the page: 

 
 

Text can then be entered by clicking on the different fields. 

8.4 Using the Template Footer 

The IMDRF Document Template also includes a document footer which appears on 
every page except the cover page.  The footer provides the following information: 
 

(A) the date of issue, and 
(B) the page number 

 
After completing the document header fields, switch to the document footer by clicking 

on the  button on the header/footer control bar.  The footer region will be displayed in a 
hatched box at the bottom of the page: 

 
 

Enter the date as entered on the cover page of the document but do not edit the page 
count as this is updated automatically by Microsoft Word.   If you see what appears to be an 
incorrect page count, e.g., Page 9 of 7, save the document and then click on Print Preview from 
the File menu.  The correct page numbers should appear.    

 
To close the header & footer view and return to normal document editing, press the Close 

button on the header/footer control bar. 

8.5 Creating a Table of Contents 

Once all the information fields have been created and the sections numbered appropriately, a 
Table of Contents should be added to the document: 
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(A) Delete the text “The Table of Contents should be created on this page. See 
IMDRF Document Format and Style Guide for instructions”’ from page 2 of the 
document; 

(B) Click on “Index and Tables” from the Insert menu on the control bar; 
(C) Select the “Table of Contents” tab; 
(D) Click on “From Template” in the “Format” window; 
(E) Ensure that the “Show page numbers” and “Right align page numbers” check 

boxes are selected and that the “Show levels” box is set to 3, and 
(F) Click on the “OK” button. 

 
The table of contents should be generated, using the numbered headings and sub-headings that 
you have added to the document. 
 
Note that the Table of Contents will require updating if changes (even small ones) are made to 
the document.  To update the Table of Contents, repeat steps (B) through (F).  When the prompt 
“Do you want to replace the selected Table of Contents?” appears, click “OK”. 
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 Appendix A: “Generic” Preface Statement for Use in All Documents  
 
  
Preface 
 

 
The document herein was produced by the International Medical Device Regulators Forum 
(IMDRF), a voluntary group of medical device regulators from around the world.   
  
There are no restrictions on the reproduction, distribution or use of this document; however, 
incorporation of this document, in part or in whole, into any other document, or its translation 
into languages other than English, does not convey or represent an endorsement of any kind by 
the International Medical Device Regulators Forum. 
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